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Turn on the Computer

To turn on the computer, press the Power On/Off switch on the computer.

Make sure that the monitor is on by pressing its separate Power On/Off switch.

Wait while the computer is booting up.
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Turn on the Computer

Once the computer is ready, you may have to log in. ( User Names ]
This is how to log into Windows XP:

1. Click on the user you

want.

)
‘g

Windows

2. Type in the password.
3. Click on the arrow or press To begin, click your user name

“Enter” on the keyboard.

[@) Turn off computer

Logging In— putting in your name and
password so you can use the computer.
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Turn on the Computer

Now you are logged in. You should be able to see the desktop and begin working on the computer.

[ Desktop }

o)
B

Internet

b
PowerPath

7J start

. 'E‘-Ei Computer documenta, ..

Recycle Bin

B 7 &) % 142
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Open Microsoft Word

Microsoft Word is a computer application. It is used to create, edit and print documents.

Open Microsoft Word by double-clicking on the
icon on the desktop. 2

1. Move the mouse so that the mouse pointer is
pointing to the Word icon.

2. Double-click on the Word icon to open it.

P — P [ [
+5 Start - e 9 O @ My Docurments O Computer docum
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Open Microsoft Word

If there is no Microsoft Word icon, follow these directions.

To open Microsoft Word from the Start button:

1. Click on Start
on the bottom
left corner of
the desktop. It
is a green
button.

A pop up
menu comes

up.

Pop-Up Menu-

i a list of choices
i that “pops” up on
i the screen

s
B

Internet

ReadFlease
FREE

(P - ¥ e F I
‘s Start - €& S O @ My Documents O Computer documenta... H ° "(_’J.,!‘a 6:56 &M
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Open Microsoft Word

2. Look for
Microsoft Word
on the list. If it

is there, click
on it to open
Word.

AN

[Pop-Up Menu ]/

£ Internet

\ Inkernet Explorer
Microsoft Office Access
2003

i Microsoft Word 2003
IG;_EI Microsoft Office PawerPaink
—| =003
Microsoft Cffice Document
Irnaging

“5 Paint
/

All Programs D

72 start

._._\; My Documents
g My Recent Documents »
j} My Pictures

.-_'_’/ My Music

g! My Computer

._':‘} My Network Places

Bﬂ Contral Panel

@, Set Program Access and
Defaulks

h% Printers and Faxes

t_)) Help and Support
I') Search
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Open Microsoft Word

3. If Microsoft Word is not on the list, click on All Programs.
Then click on the MS Word icon in the pop-up menus.

Click on the
Word icon.

N

[ All Programs ‘]\>

& Internet
Internet Explorer

’ri_l E-mail
= I} Microsoft Office Cutl

Gﬂ Owner's Manual

F. K _ Adobe Acrobat 7,
" Professional

T ricrosoft Gffice wWar

2003

& WinRAR

@ WordCue Trainer
@ RealPlayer

i ]
ﬁ. Disk. Defragmenter

All Programs L]

E Microsoft Office Publ

Fax
#
-]
e
@

C]

'J start ol 3

Dell Accessories

Dl Picture Studio v2.0
Dell Support

Games

Intel Metwork, Adapters
Microsoft OFfice
Microsoft Qutlook with Business Contact Manager
Modem Helper

Musicmatch

MetWaiting

PrintMe Internet Printing

QuickTime

Real

Sonic

Startup

Adobe Reader 6.0

Dell Media Experience

Internet Explorer

Micrasoft Plus! Photo Skory 2 LE

Cutlook Express

Remate Assistance

Wfindows Media Plawver

Windows Messenger

HeadHlease LU

RealeWriter 3.0.1

' Aequus Technologies

Map Puzzles

Mathematics Worksheet Factory Lite

Microsaft Office Tools >
Microsoft OFfice Excel 2003

r

| D] Micrasaft Office Outlook 2003
@ Microsoft Office PowerPoint 2003

@ Microsoft Office Publisher 2005

m Micrasaoft Office Word 2003
Microsoft Office Access 2003
ﬂ FrontLoaok Screen Capture

pages,

@) FrontLook Screen Capture Help
B FrontLook Screen Capture Manual

2 Uninstall FrontLook Screen Capture
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Type Your Writing

/\X/hen you open \

Word, you will see a
blank page.

The cursor will be
blinking on the page.

Type a few sentences
here. Write about
your plans for using

the computer.

i Cursor-

| The blinking line on
i your screen.

When you type, your

i words show up where
i the cursor is.

4 Document1 - Microsoft Word

! Fle Edit View Insert Format Tools Table Window Help AdobePDF  Acrobat Comments Type a question for help |+ X
. E |Gl g w0% v@lﬂl&sad!
— S
P A4 normal [ =L =iz EEIR-W. AL
H = = 3

Page 1 Sec 1 11 At 17 ln1 Col1 REC| |TRK| [EXT | |[OVR

E,i-[ Document1 - Microsaf...
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Check Your Spelling and Grammar

Microsoft Word will check the spelling and grammar on your writing. You may

notice that there are red or green squiggly lines under some of the words.

Red lines mean a spelling error and green lines mean a grammar error.

! Fle Edit View Insert Format Tools Table Window Help Adobe PDF  Acrobat Comments

= = AN AN -

Type a question for hel

o
4

L - S e 2

Everbdy makes mistakes typing on the computr.

; Sometims. Microsoft Word fixs the mistaes right awav.

Sometimes, red and green lines shows up under the words. |

[ B I B
' | ' '

y|")'@'|&|_2m@§§|@ﬂ 110% vli'ﬁmesNewRoman 12 - | B I H|

[ S R IR
' | '

[+
- E
=]
¥
= = [5]= ¥ 0 I EE——S,
o s [aoshopes N N DO A @I O-L-A-=S=Z@adf
Page 1  Sec 1 11 AtL7” In5 Col5 ||rec|m|[BT|ow|] BX
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Check Your Spelling and Grammar

Microsoft Word will sometimes give you ideas how to fix your errors. To see these
suggestions, right-click on the word that is underlined.

- O]
i Fle Edit Wew Insert Format Tools Table Window Help Adobe PDF  Acrobat Comments Type a question for help  » X
SR RS98I OREG e 0% - Bimmesnewronan -2 -|B L pEE== A

Everbdy makes mistakes typing on the compultr.

I computer
- Sometims, Microsoft Word fixs the mistaes rigl a t

compute
Sometimes, red and green lines shows up under

Ignore All

Add to Dictionary
AutoCorrect »
Language 3
Spelling...

Look Up...

B¢

R fa Cut
- S| Copy

E Paste

“ o |

T
8
&

%
El

fpaws i [Ashepes N N DO A BEIS-L-A- === addj
I Page 1 Sec 1 Y1 at 177 Ln 5 Col 58 REC TRK EXT OVR Qx

-

hese are the
suggestions.

Click on the one
that looks like the
right spelling.

Word will make

writing.

the change in your

\

/
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Save Your Work

When you are done working, you will want to save your document.

1. Go to File on the menu bar. You will use Save or Save As.

| Saving Text.doc - Microsoft Word

DEHam GRY & 2R o-o- @POBE[@E T % - @ .

File | Edit View Insert Format Tools Table Window Help Type & question for help = X
O new.. b B 7 UEEESE-EEEEO-2-A.
= Open.. Cirl40 - ia- e @
ME save Ctrl45 =
RS R R R TR Ry -
Save As... : : |

/ Page Setup...

@ Print Preview
& print... Crl+P

t Save Or Save AS /] 1Ci\. . \computer course\Saving Text.doc Text MS Word

2 C:\...\Formatting Text in M5 Word.doc

3 C\.. . \Format text sample.doc
osoft Word. vou can save vour document to a filename using the Save or Save As

4 C:\...\computer course'\How to save.doc A v
¢ the File menu option.

Exit

H D ow (A

Page 1 Sec 1 11 At 21~ In8 Co35 REC TRK EXT OWwR B

Eventlink V... u_l The Menu B... ITE. Document2... u_l How to sav... LTE. Format tex...
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Save Your Work

When you click on the Save button for the first time on a document, this box appears:

The box is called
Save As the first
time you save

your document.

2. Click on the
down arrow and
choose where you
want your docu-
ment to be saved.

3. Type in your
own file name.

&l Document3 - Microsoft Word

4. Click on Save.
/

DEELSE SRAY | {BRY o-« QPOR=@| 8 T % -3,
File Edit View Insert Format Tools Table Window Help pe a question for help = X
<4 MNormal + TimesMewRoman - 12 - B F U E == =~ = i= i = - A . &v .
Final Showing Markup v Show~  d&f Wp Wp - Ap ﬁv E} = .
o E e Seamees B
Save As
Save in: IE; computer course j - @ ¥ 5 E - Tools-

Saving

Within M|

optiosrn)

v

History

&

i @ [Eurnit_os

My Documents

T 7

Desktop

Favarites

=

File name:
W

Places

(Cunit_01
(CHunit_o2

Unit_04

[Cunit_os

(Sunit_o7

[Cunit_og

~%2 Menu Bar - Edit.doc
~Srmat text sample.doc
~Srmatting Text in MS Word.doc
~Sying Text.doc

~Sw to save.doc
Components of a Window.doc
Cover Letter Sample prac.doc
(_ | i} ]

@Cover Letter Sample.doc

@Creaﬁng a Word Document.doc

1 Edit. doc

@Format text sample. doc

Formatting Textin MS Word.doc

How to save.doc

Moving a file the long way.doc

Posttest.doc

Pretest.doc

Recyde Bin.doc

Saving Text.doc

Search.doc

Searching for files, doc

Skills Standards for Computer Literacy Class

Spelling and Grammar Check in MS Ward.dot
2|

Saving Text

LI/¢ Save

Save as type: IWord Dacument (*.doc)

H D W4

AutoShapes » ™. \DD‘E:I@ &'ivévf—_ﬁ.

Sec 1

11 At 1.97 Ln 5 Col 1

EventLink ¥2.3 Sign In

REC TRK BXT OWR [BF

71 & Microsoft Word
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Save Your Work

What is the difference between Save and Save As?

When you save a file for the first time, the Save As
box appears. This lets you name your document and
save it in the folder that you choose.

When you want to save your file again you will use
Save. This will save your file in the same way you
saved it before.

If you want to save your file under a different folder
or name, you can click on Save As. Then you can
change the name or the folder.
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Close Microsoft Word

To close Word, click on the

x in the top right of your screen.

- B]X]

Ui \Dociimentd = MicnosoftWornd

I File Edit View Insert Format Tools Table  Window

Type a question forhelp  » X

Help Adobe PDF  Acrobat Comments

« o w0
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Open Your Writing Again

If you have saved a document and closed it, here is how to open it again:

G | Saving Text.doc - Microsoft Word

DEEHSE SGRY 1R v-o QBEOB=B| BT o -8,
EiT‘ Edit Wiew [Insert Format Tools Table Window Help
1. Click on File—" |0 &= Bz U E-iEEEEE-L2-A-

Z Qpen... Ctrl+0 } . ﬁ . ;@ @ .
I Save Ctrl+s D a e e
Save As — : : : : : : : : : :
Page Setup...
& Print Preview
2. Click on Open. S erint.. Cirl+p
1C:\,..\computer course'Saving Text.doc Te‘xf MS Hford

2C:\...\Formatting Text in MS Word. doc

3C:\..\Format text sample.doc

4C:\,.. \computer course'Haw to save.doc osoft '\‘\- ord, vou £an,save vour document to a filename using the Save or Save As
r the File menu option.
Exit

£«

Draw= [3 Autoshapes= . W O E 4l B & d-Z-A-==Z85 8 @.

Page 1 Sec 1 11 At 2,17 ln 8 Col 35 REC TRK EXT OvR B
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Open Your Writing Again

When you click on Open, you see
this box. The box is called Open.

1. Click on the down arrow. Look (| Wy Docments, 7| & -E @ X £ EF - Toos~
Mame = Size | Type Date Modified #
[Ch5tudent Data File Folder 8/23/2004 5:4
History [Chsubfolder 1 File Folder 11/3/2004 3:1
) test docs File Folder 11/9/2004 2:0
2. Find the file that you want and [C3)Test Folder File Folder 9/7/2004 3:19
CliCk on it. @ |y Vocabulary Building File Folder 6/2/2004 1:33
My Documents | | (=) xhkdmjidxfl hapoistig[o File Folder 11/24/2004 3:
Ej ~&th's document. doc 1KB Microsoft Word Doc...  12/6/2004 3:0
E @ Becoming an Effective Drill Se... 24KB Microsoft Word Doc...  3/18/2004 2:3
@Beth's document.doc 24KB Microsoft Word Doc...  12/6/2004 2:4—
Desktop B common Activities that Adults. .. 26KE Microsoft Word Doc...  3/30/2004 11:
@muer letter- points skk. .doc 24KB Microsoft Word Doc...  10/13/2004 2:
- desktop.ini 1KB Configuration Settings  9/19/2003 8:2
@DDL.doc 24KB Microsoft Word Doc...  7/20/2004 12:
3. Click on Open to get the file.— #)ESC student data.xs 15KB Microsoft Excel Wor...  5/20/20047:4 %
b — l A
File name: I = Open | =
Flaces Files of type: |‘”' Files (=.%) j Cancel |
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Print

View Insert Format Tools Table Window Help AdobePDF  Acrobat Comments

&JGEEE|@H1E% THETIITIESNE

! 2 1 L T R |

Ctrl+0

1. Click on File.

=
Save Ctrl+5
=
Save As...

Save as Web Page. ..
i a
e |

File Search...

2. Click on Print. Permission ,

Versions...

Web Page Preview

Page Setup...

Print Preview

|l

Print... Ctrl+P

Send To »

Properties

1 H:\Documents\,. . Yopening a document. doc
2H:\...\5pelling_and_Grammar_Chedk_in_...

3 H:\...\general operating system.doc
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Print

riile 2 x|
This box is called Print. Printer

Mame: | uqf HP Cfficejet 6200 series | Properties
e —: , Find Printer...
Type: HP Officejet 6200 series
Where: USE001 [] Print to file
Comment: [ ] Manual duplex
Page range Copies
(= all Mumber of copies: |ﬂ @
O Current page Selection
() Pages: | | 11 11 Collate
Enter page numbers andfor page ranges
separated by commas. For example, 1,3,5-12
Print what: |Dncumer1t mi

. Pages per sheet: 1 page
Print: |.l5.l| paaes in range el | i .

Scale to paper size! | No Scaling

Options... i QK ¢ i | Cancel |

3. Click OK.
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Shut Down the Computer

Never turn off the
computer by pressing
the On/Off switch on
the computer.

To turn off the computer:

1. Click on Start on the bottom left corner
of the desktop.

2. You will get a pop-up menu of choices. —

3. Click on “Turn Off Computer™ -

(or Shut Down).

p

L

W

‘j' DL Participant

Internet
Internet Explorer

Microsoft OFfice Word 2003
(3

Microsaft Office PowerPoint
2003

Microsoft Office Document
Imaging

¥

Paink

—

&ll Programs D

.__;'i My Documents

5 My Recent Documents F

::5} My Pictures
_-_'jr My Music

5! My Compukter

‘Tg My Metwork Places

g Conkral Panel

@, Set Program Access and
Defaulks

}zé Printers and Faxes

t!) Help and Suppart

| Turn OFf Computer

. tEl Computer documenta. ..
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Shut Down the Computer

[\)(/hen you click on Shut Down, you see this box. ]

V)
7|

Internet

4. Click on Turn Off.

ReadFlease

FREE

¢4 Start re s

Turn off computer

Stand By

Cahcel

. EE' Camputer documenta. ..
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Shut Down the Computer

Note: In some older versions of Windows XP, you may see a drop-down box when you click on Shut

Down.

1. Click on the arrow
to get the list.

2. Click on Shut
down.

3. Click on OK.

@ What do you wartteecomputer to do?

Restart e
LDE off lilab

Restart
Stand by

4; Ok H Cancel H Help

DIREC vwamt auas
ally]
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